
constantly measures mo-
tion for more efficient fit-
ness apps, and a much-
improved camera with a 
new burst mode for taking 
many shots in succession. 
Also new is the “Touch 
ID” fingerprint sensor, 
which lets you unlock the 
5s and make iTunes pur-
chases. The iPhone 5s is 
available in three colors, 
and both models will ship 
with the new iOS 7 oper-
ating system and five free 
apps (Keynote, Numbers, 
Pages, iMovie, and iPhoto).
Both devices will be avail-
able for purchase online 
and in-store on September 
20th.� www.apple.com

Best Document 
Scanner
If you need a clever, handy 
scanner to digitize docu-
ments (not photographs!), 
check out Fujitsu’s  
ScanSnap iX500. At $420, 
it’s not cheap, but it’s in-

News & Rumors

Amazon’s Founder 
Buys Washington Post
Amazon.com’s CEO and 
founder, Jeffrey P. Bezos, 
bought the Washington 
Post for $250 million. It’s 
anyone’s guess what kind 
of digital world he’ll create 
from the Post, but in the 
meantime, check out the 
news story and a 2.5-min-
ute video about Bezos cre-
ated for the New York 
Times at  
www.tinyurl.com/nzxxj6m.

Thunderbolt & USB 
Speeds to Double
The next generation of 
both Thunderbolt and 
USB 3.0 will be twice as 
fast, and USB 3.0 will also 
increase its power trans-
fer by 10 times. Thunder-
bolt’s new speed of 20Gbps 
will be fast enough to han-
dle 4K video editing from 
external drives, along with 
substantially faster trans-
fer speeds for large files. 
At the same time, USB 3.0 
will jump beyond FireWire 
speed, at 10Gbps, and will 
be able to pass 100 watts 
of power through to pe-
ripherals—enough to run 
a display, charge several 
handheld devices, or even 
run a laptop computer. Ex-
pect devices that support 
the new specs in late 2014. 
For much more info, see  
www.tinyurl.com/o8x6mq2.
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Tips & Tricks

Photoshop Layer Tips
At CreativePro.com, Mike 
Rankin posted “Photoshop 
10 Essential Tips: Work-
ing with Layers.” Read it at 
www.tinyurl.com/mcn7wyf.

Improve Your Life with 
creativeLIVE 
This could be the best tip 
of the year: You can dra-
matically improve your 
quality of life by watching 
the free workshops at  
www.creativelive.com. Al-
though they started their 
company by photography, 
their true goal is to teach 
people to be more power-
ful. Upcoming workshops 
include business growth, 
digital drumming, over-
coming fear, starting a 
business, being creative 
under pressure, medita-
tion, travel hacking, sell-

…more Tips & Tricks on page 10

New Hardware

New iPhone Models
Two new iPhone models 
will be available on Septem-
ber 20: the 5c and the 5s. 
The lower-priced 5c 
($99/$199 for 16GB/32GB 
with a two-year contract) 
has most of the same specs 
as the iPhone 5, but it’s 
made out of plastic, comes 
in a variety of colors, and 
has improved battery life. 
The new iPhone 5s 
($199/$299/$399 for 
16GB/32GB/64GB with 
a two-year contract) in-
cludes a 64-bit A7 pro-
cessor that’s up to twice 
as fast as its predecessor, 
a new M7 processor that 

New Software

Automatically Optimize 
Your Photos with 
Organic Imaging
The concept of “micropay-
ments” has been a long 
time in coming. The idea 
is that you pay a small 
amount for each time you 
use a program or service, 
so you don’t have to pay a 

…News continues on page 2

…Software continues on page 4

…Hardware continues on page 2

big price for a powerful so-
lution you may only use 
occasionally.
Organic Imaging is an ex-
cellent example of this 
kind of service for pho-
tographers and layout art-
ists. Their application in-
telligently optimizes your 
images for just ten cents 
each. It will even process 
250 images for free, so you 
can see if it works for you. 

H.265 Cuts Video 
Transmission by Half
Due early next year, the 
new H.265 video-encod-
ing standard is twice as 
efficient as the existing 
H.264 standard used by 
just about everything. 
Not only does this make 
the transmission of Ultra 
HD, or 4K, video possible 
over existing broadband 
services, it will also make 
it possible to use existing 
home networking technol-
ogy to distribute HD video 
wirelessly inside the home. 
Learn more from Digital 
Arts Online at  
www.tinyurl.com/d2nk3ao.
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Creative Business
www.CreativeBusiness.com

Graphic Design:USA
www.gdusa.com

InDesign Magazine
www.InDesignMag.com

Layers	 www.LayersMagazine.com

Mac Life	 www.MacLife.com

Macworld	 www.macworld.com

Photoshop User
www.PhotoshopUser.com

CreativePro.com
www.CreativePro.com

MacFixIt	 www.MacFixIt.com
MacInTouch	 www.MacInTouch.com

MacNewsNetwork
www.macnn.com

The Mac Observer
www.MacObserver.com

MacUser	 www.MacUser.co.uk

InDesign Secrets
www.InDesignSecrets.com

Planet Quark
www.planetquark.com

Version Tracker
www.VersionTracker.com

Sources We Monitor (so you don’t have to)

Report: Quark  
Is a Unique Leader in 
Dynamic Publishing
Every year, Frost & Sulli-
van updates its report on 
the dynamic publishing 
solutions market. You can 
download the summary 
from their latest report at 
www.tinyurl.com/pqt398k.

According to the report, 
“Quark is unique in of-
fering an end-to-end dy-
namic publishing solution 
that includes profession-
al desktop design, struc-
tured authoring and a 
complete platform for the 
management and delivery 
of content.”

Single Apps  
for Creative Cloud  
for Teams
Users of Creative Cloud 
for Teams can now pur-
chase single-app member-
ships instead of being re-
quired to purchase all the 
available programs. The 
plan costs $30 per month 
per user (or $20/month/
user for those upgrading 
from CS3 or above). Com-

panies can choose any one 
of the Creative Cloud apps, 
and the plan also includes 
the standard 20GB of stor-
age per person and access 
to Behance ProSite.

www.adobe.com

Macworld 2014 
Changes Dates
IDG changed the dates for 
Macworld/iWorld Expo 
2014 from February 1–3 
to March 27–29. The ven-
ue is also changing from 
Moscone West to Moscone 
North. More info:  
www.macworldexpo.com

Hidden Exhibits  
Now Online
The Boston Public Library 
has been scanning and 
photographing its normal-
ly unavailable collection 
of art and design work to 
share the content online 
through Flickr. The collec-
tion includes more than 
62,000 items such as post-
cards, labels, posters, man-
uscripts, and sheet mu-
sic, and the items can be 
viewed for free. 
Other libraries are start-
ing to make their collec-
tions available online, too, 

and many items are copy-
right-free since they’re old 
enough to be in the public 
domain. See it at  
www.tinyurl.com/cmsxu7x.

News (from pg. 1)

credibly fast and handy— 
it can scan wirelessly to 
your iOS or Android de-
vice or wired to your 
desktop computer. It can 
scan both sides at once, 
at about two seconds 
per sheet! It can convert 
scanned text to editable 
text (OCR) and send di-
rectly to Evernote, Google 
Docs, or Microsoft Word. 
For more info, read David 
Blatner’s story at  
www.tinyurl.com/qaxupl8.

Throwable Camera
Inventor Steve Hollinger’s 
intelligent throwable cam-
era, dubbed the Squito, is 
a softball-sized plastic ball 
that contains three camer-
as and image stabilizers. 
When thrown, Squito 
takes video or multiple im-
ages, stitches them togeth-
er, and sends them wire-
lessly to a phone, tablet, 
or computer. The device is 
still in development, but it 
has awe-inspiring implica-
tions for video capture and 
photography.
Learn more at  
www.serveball.com.

Faster  
Apple Wireless Devices
Apple recently updat-
ed the AirPort Extreme 
($199) and Time Capsule 
($299/2TB or $399/3TB) 
base stations to support 
the faster and more robust 

Hardware (from pg. 1)

802.11ac standard. These 
new devices offer wireless 
speeds that outperform 
many wired network con-
nections, assuming you 
have a new Mac that sup-
ports 802.11ac. 
The redesigned base sta-
tions include three Giga-
bit Ethernet ports, a USB 
3.0 port, and a WAN port, 
and they still provide dual-​
band 2.4GHz and 5GHz 
signals without suffering 
any performance loss.

www.apple.com

Numeric Keypad  
for Apple Keyboard
iCalc ($50) is a numer-
ic keypad with a built-in 
LCD display for use as a 
calculator. What’s cool is 
that it magnetically snaps 
to the side of your Apple 
Wireless Keyboard to be-
come (almost) one with 
the keyboard! Use it when 
you need it, stow it away 
when you don’t. Get it at 
www.smklink.com or Amazon.

CMYK Coffee Cup
DCI has a line of reusable 
coffee cups—appropriate-
ly named “I Am Not a Pa-
per Cup”—that look like 
disposables. In reality, 
they are made from por-
celain and have a silicon 
lid. The RGB/CMYK color 
spectrum version quickly 
caught our eyes! $17 from 
www.tinyurl.com/bunm8l4.

LaCie’s 4TB Hard Drive
LaCie’s Blade Runner is a 
limited-edition 4TB hard 
drive ($300) designed by 
Philippe Starck. It has an 
organically shaped en-
closure designed to help 
keep the drive cooler and a 
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Competitions

Digital Magazine  
Awards 2013
Deadline Sep 27

www.tinyurl.com/mb5cfpm

HKDA Global Design 
Awards 2013
Deadline Oct 25

www.tinyurl.com/los5zea

Andreu World 
International Design
Deadline Dec 9

www.tinyurl.com/lferxlm

Hiiibrand Awards 2013
Deadline Dec 31

www.tinyurl.com/lqvynpp

Average Used Mac Prices

iMac Core i3 3.2 GHz 27” Al (Mid-2010)(MC510LL/A)�������������������������������� $594
iMac Core i7 2.93 GHz 27” Al (Mid-2010)(MC511LL/A)������������������������������ $879
Mac Pro 3.2 GHz Quad-Core (2010) (3560 Series) (MC250LL/A)�������������� $1138
MacBook Air Core 2 Duo 1.86GHz 13.3” (Late 2010) (MC504LL/A)������������� $534
MacBook Pro Core 2 Duo 2.4 GHz 15” (Unibody) (MB470LL/A)������������������ $577
MacBook Pro Core i5 2.53 GHz 15” (Mid-2010) (MC372LL/A)�������������������� $907
MacBook Pro Core i7 2.7 GHz 13” (Early 2011) (MC724LL/A)��������������������� $942
(�Editor’s note: We multiply the price listed through Apple’s trade-in program at  
www.tinyurl.com/24s6q46 by 1.5, which we find to be close to market value. 
We recommend checking eBay’s Completed Listings for the most accurate prices.)

Upcoming Events

Sep 23–25
Publishing Business 
Conference & Expo
New York�  

www.publishingbusiness.com

Oct 10–12
Head, Heart, Hand:  
AIGA Design Conference 
Minneapolis�

www.tinyurl.com/bvgwv37

Nov 5–7
HOW Interactive Design Conf 
Chicago�

www.tinyurl.com/mqr56su

Photoshop Deep Dives
with Lesa Snider (FREE!)

Content Aware & Cloning�Oct 14

Video Editing & Animation�Oct 15
Photoshop Elements for 
Photographers���������� Oct 16

www.creativelive.com

Adobe Create Now  
World Tour
Boston���������������������Sep 26 
Portland��������������������� Oct 1
Denver��������������������� Oct 15
Toronto��������������������� Oct 17
Chicago ������������������� Oct 22
Los Angeles������������� Oct 29
Washington��������������Nov 12
Atlanta���������������������Nov 14
Seattle�����������������������Dec 4
Las Vegas����������������������TBA
Orlando ������������������������TBA
New York ����������������������TBA
European cities:�See website

www.tinyurl.com/cc2cd28

 

Photographic Artistry 
with Adobe Photoshop

with Ben Willmore
Tampa������������������������� Oct 4
Atlanta ��������������������� Oct 16

www.tinyurl.com/acmz6cn

An Event Apart
Austin������������� Sep 30–Oct 2
San Francisco������� Dec 9–11

www.aneventapart.com

Dec 7–10
Color Management Conf.
Phoenix� www.cmc.printing.org

Mar 27–29, 2014
Macworld/iWorld Expo 
San Francisco

www.macworldexpo.com

USB 3.0 interface for fast-
er data transfer speeds. It 
also supports USB 2.0, but 
it doesn’t include FireWire 
or Thunderbolt ports.

www.lacie.com

M-DISC 1000-Year 
Optical Discs
Millenniata claims its  
M-DISC writable optical 
discs will last up to a thou-
sand years, unlike tra-
ditional burnable discs, 
which have about a seven-
year life span. 
Instead of using a pho-
tosensitive layer to store 
data, M-DISC creates pits 
when data is written, much 
like commercial DVD and 
Blu-ray discs. The down-
side is that you’ll need a 
special drive to write to the 
discs, but any DVD or Blu-
ray player can read them. 
The company’s DVDs 
(10 for $30) are available 
now, and its Blu-ray discs 
should be available around 
June. For more informa-
tion about compatible 
drives, visit  
www.tinyurl.com/cbmljv3.

www.mdisc.com

Spare Power
Need added power for your 
iPhone or iPad when trav-
eling? Get a FatCat. Fat-
Cat chargers are small and 
have greater battery capac-
ity than the devices they 
are designed to charge. 
FatCats come in three siz-
es—a super-slim Charge-
Card for a cell phone or 
iPod; a 4200mAh Power-
Bar, smaller than most cell 
phones with enough pow-
er to charge one twice; 
and the 9600mAh Power-
Bar, designed to recharge 
an iPad at least once or a 

smart phone four times. 
And FatCats will even re-
tain 70 percent of their 
power for up to a year if 
not used! Prices range 
from $50 to $130. Learn 
more at www.fatcatgear.com.

eSATA to USB
For years, high-speed ex-
ternal hard drives included 
an eSATA port for the fast-
est data transfer speeds. 
But now USB 3.0 is being 
included on new comput-
ers instead of eSATA. To 
attach an eSATA drive to a 
USB 3.0 port and get USB 
3.0 speed, get Newer Tech’s 
eSATA to USB 3.0 Adapt-
er ($30). It’s simply a cable 
adapter, requiring no soft-
ware or external power. 
More info:  
www.tinyurl.com/mw7gd5p

Yiynova Tablet
If you love Wacom’s Cin-
tiq tablets but can’t justi-
fy the price, there’s an al-
ternative that many peo-
ple say works better than 
the Cintiq. A company 
in China called Yiynova 
has a 19-inch tablet with a 
1440x900 built-in screen. 
The MSP19U has a .28 dot 
pitch, which isn’t as sharp 
as the Cintiq, but it has 
4,000 levels of pen pres-
sure versus the Cintiq’s 
2,048, and many reviewers 
said it didn’t suffer from 
the lag problem that they 
often experienced with the 
Cintiq. It costs $600 on 
Amazon, versus $1,200 for 
Cintiq’s 13-inch model. It 
also has a 4.5-star rating 
with over 70 reviews. 
Give it a look at  
www.tinyurl.com/l97y2b5.
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After that, you buy credits 
and process away!
If you have a lot of photos 
to process, or you simply 
want to be sure the images 
in your publication are the 
best they can be, this ser-
vice can save lots of time.

www.organicimaging.com

ContactPage: The Best 
Contact Sheet Creator
Badia’s ContactPage 5 
($15) is the easiest way to 
create professional-look-
ing contact sheets of im-
ages with captions. Use it 
to create picture catalogs, 
proof sheets, and pho-
to books (or any time you 
need to quickly browse or 
print pictures with full de-
scriptive text captions!).
ContactPage can build 
a PDF, image file, slide-
show, or page layout doc-
ument—using Adobe In-
Design, QuarkXPress, or 
iWork’s Pages—with the 
pages, backgrounds, imag-
es, and captions custom-
ized to your liking. 
You can specify margins, 
page size and background, 
grid rows and columns, 
picture fitting, headers 
and footers, box colors and 
shapes, strokes, drop shad-
ows, opacities, and more. 
The caption may include 
the picture name and pic-
ture attributes, such as full 
path, file size, kind, col-
or model, image resolu-
tion, creator application, 
date modified, dimen-
sions, containing folder, 
and copyright info.

www.badiasoftware.com

Bulletproof  
Video Conversions
When you’re creating mo-
bile websites or apps and 
using video footage, it can 
be hard to find the best 
setting for video conver-
sion. If you choose the 
wrong format for encod-
ing or conversion, the au-
dio track or the whole vid-
eo may not show or may 
play incorrectly. 
The one-click solution? 
Miro Video Converter (do-
nationware) at  
www.mirovideoconverter.com.  
It has presets for every 
kind of device you’ll en-
counter, and it simply 
works.

Find and Use  
Hidden Glyphs
X04 Studios’ Ultra Char-
acter Map ($20, Mac App 
Store) is a standalone Mac 
app that gives you access 
to and control over your 
fonts. This little utility lets 
you access any glyph in a 
font, create sets of favor-
ites, compare fonts, and 
create font catalogs. 
You can view text that has 
been copied from oth-
er apps and easily see the 
keystrokes needed to pro-
duce each character—even 
those that require multiple 
steps. Ultra Character Map 
also lets you view, copy, 
and paste Emoji, HTML 
characters, and Unicode 
information.

www.tinyurl.com/mojhn69

Rip Protected DVDs
Sometimes, you need to 
make a legitimate copy of 
some or all of the content 
on a copy-protected DVD. 
If you find yourself in that 

position, try Mac DVD-
Ripper Pro. It costs $20 at 
www.macdvdripperpro.com.

Convert Fonts to Objects
If you need an entire font 
converted to vector ob-
jects, check out FontPes-
tle. This handy app ($4.99, 
Mac App Store) exports 
every character from an 
OpenType or TrueType 
font to individual objects 
in PDF, PNG, TIFF, or GIF 
formats. The app even in-
cludes 10 symbol fonts for 
you to convert as a start-
ing point. 
Before exporting, you can 
customize fill, stroke, and 
background, and the re-
sulting files can be shared 
with others from with-
in the app. Requires OS X 
10.8 or later.
Learn more at 
www.tinyurl.com/pz3mvsp.

ProofHQ for Proofing
If you spend a lot of time 
managing the approval 
process, consider Proof-
HQ. For about $10/month 
per team member, Proof-
HQ lets members mark 
up proofs, shows the sta-
tus of the proof, and tracks 
all changes, approvals and 
so on. It also integrates 
with Microsoft Sharepoint, 
Basecamp, WebNative, 
and other CMS systems. 
See the demo and get more 
info at www.proofhq.com.

Find Network Problems
Got network issues? In-
stall Speedy Net ($2) on 
two Macs on your network 
and view file transfer de-
tails over Wi-Fi or Ether-
net. Get it at  
www.mauriciosantos.net.

Software (from pg. 1)
$40 USPS Shipping 
System
Brinscall Software’s send-
IT 3 ($40) can verify U.S. 
postal addresses, calculate 
shipping costs, and create 
USPS shipping labels. It ob-
tains shipping fee informa-
tion direct from the USPS 
and also works with sup-
ported USB digital scales 
for automatic calculations. 
It can provide shipping 
history, package track-
ing, drag-and-drop address 
fields, and pasting of ad-
dresses from the clipboard.

www.brinscall.com

Compare PDFs
If you work with lots of 
PDF documents, you may 
need to compare two ver-
sions of the same PDF. 
While Acrobat Profes-
sional provides this fea-
ture, another product fo-
cuses exclusively on mak-
ing comparisons easier for 
you: PDF Comparator Pro-
fessional, from Premedia 
Systems. 
Now in its third genera-
tion, it comes in a $125 
“Standard” version and a 
$195 “Professional” ver-
sion. They claim it’s bet-
ter than Acrobat in some 
ways, including ease of 
use, clarity of differences, 
greater control of compar-
ison parameters (including 
some that Acrobat misses), 
and it’s faster. 
Our favorite feature is the 
ability to open three win-
dows to view a pair of pag-
es, with or without syn-
chronized sizing, zoom-
ing, and scrolling—one 
window for each docu-
ment, and a third to dis-
play their differences.

www.premediasystems.com
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iWatermark
Plum Amazing’s iWater-
mark ($1.99) lets you wa-
termark images on your 
iPhone or iPad. You can 
create text-based marks 
using any of the 67 includ-
ed fonts or use graphics 
from your computer to not 
only protect your imag-
es, but brand them as your 
own. For further branding 
options, a QR code can be 
used as the watermark to 
communicate a website or 
company info right from 
the image. 
You can even take a pho-
to of your signature using 
the iPhone’s or iPad’s cam-
era and use that as the wa-
termark.

www.plumamazing.com

Professional  
Keynote Themes
Having a good set of 
themes to work with when 
creating a presentation in 
Keynote helps you get your 
ideas across without having 
to spend tons of time de-
signing the look and feel as 
well. Jumsoft has released a 
set of 15 professional Key-
note themes ($50) that are 
clean and elegant, so you 
can spend more time work-
ing on the graphics that go 
into your presentation and 
less on the bones of the pre-
sentation itself. 
With up to 50 master 
slides each, these themes 
include templates with 
headline, body, and bul-
leted text and layouts de-
signed for dragging and 
dropping of photos and 
graphics. Also includ-
ed are matching tables, 
custom bullets, and cus-
tom shapes for easily plac-
ing and cropping graphics. 

Even with so many com-
ponents included, the Jum-
soft themes allow for ob-
ject-level customization, 
including changing back-
ground images and fonts 
in text boxes.

www.jumsoft.com

The Photographer’s 
Ephemeris
The Photographer’s Ephem-
eris has been around for a 
while as a free Adobe AIR 
application, and now Ste-
phen Trainor has brought it 
to the iPad ($8.99 on the App 
Store). This valuable tool for 
photographers integrates ce-
lestial data with precise glob-
al positioning, satellite, and 
terrain maps from Google 
and puts the information in 
a visually pleasing interface. 
Plan out the right time and 
location for landscape and 
outdoor photography using 
information such as time and 
direction of sunrise/sunset 
(even moonset!), phase of the 
moon, and twilight times. 
Advanced features include 
elevation and automatic ti-
mezone detection as well 
as being able to determine 
when the sun will be vis-
ible behind mountains or 
hills! Get it at  
www.tinyurl.com/kc7sj5t. 

Clips: Multi-level 
Clipboard
Conceited Software’s Clips 
($8) keeps track of all your 
cut or copy operations and 
lets you search to retrieve 
them. You can also assign 
abbreviations to clips, so 
you can type a few letters 
to insert a signature or oth-
er boilerplate text. Clips are 
stored according to appli-
cation, and you can even 
drag and drop an email, text 

snippet, or Web page direct-
ly into a Clips panel. 
You can also create “smart 
clipboards” that automat-
ically update with any 
clip that contains text you 
specify.

www.conceited.net

SeeFile 5
If your company often 
shares files with clients—
perhaps photos or project 
files—SeeFile 5 ($699 and 
up) may streamline the 
process and add capabil-
ities you didn’t know you 
could have. 
Your clients can use any 
Web browser to view, ap-
prove, upload, and down-
load files from their own 
password-protected folders. 
SeeFile creates thumbnails 
and slideshows for files on 
the fly, and clients can drag 
to highlight areas for no-
tation or even crop imag-
es. The latest version offers 
email notification of chang-
es to your files, a complete 
log history per user and ac-
tion, annotating multi-
page PDF files, and a cloud-
based server option.

www.seefile.com

GadgetTrak Finds  
Your Stolen Laptop
For just $35 per year, Gad-
getTrak will enable you 
to monitor your laptop in 
case it’s stolen. You install 
software on your comput-
er, and then after you no-
tify GadgetTrak that your 
laptop was stolen, it uses 
your laptop’s camera to 
take photos of anyone us-
ing it and also records 
their location using Wi-Fi 
positioning. 

GadgetTrak also allows 
you to quickly file a po-
lice report, and it even for-
wards the IP address be-
ing used by that computer 
to the authorities, poten-
tially locating the laptop in 
real time.

www.gadgettrak.com

Graphic Inspector 1.7
Zevrix’s Graphic Inspector 
1.7 ($40) is a remarkably 
handy, affordable utility 
for seeing every attribute 
of a vector or raster graph-
ic file and also for quickly 
finding all files that match 
any chosen criteria. For 
example, you could ask it 
to warn you about images 
below a certain resolution 
or with/without particular 
ICC profiles, RGB mode, 
compression, camera set-
tings, spot colors, or fonts.
To use Graphic Inspector, 
you drag one or more files 
or folders onto its icon or 
into its inspector window. 
You can also choose them 
from within its clever, built-
in file navigator. For the 
amount of information dis-
played, its interface is im-
pressively straightforward. 
You can even export file 
data as a text file, preview 
images, and open or reveal 
files in the Finder. We’re 
impressed with its rare 
combination of price, utili-
ty, and thoughtful design.

www.zevrix.com

Create Typographic  
Art on the iPad
Sometimes having an app 
that just gets the creative 
juices flowing can be in-
dispensable to a design-
er. TypeDrawing for iPad 
($2.99 on the Mac App 

…Software continues on page 6
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for a way to wear your cre-
ative badge on your skin 
without committing to ink, 
Tattly has you covered!

www.tatt.ly

Find the  
Best Prepress Talent
PrintWorkers.com con-
nects job seekers with em-
ployers. Job seekers can 
post resumes online and 
apply to any position on  
the site at no charge, and 
employers can post open-
ings and view profiles for 
a fee.

Wirecutter for  
the Best Gadgets
When you’re looking for a 
product for your office or 
home life, have a look at 
The Wirecutter at  
www.wirecutter.com. 
Their experts recommend 
the best product in many 
categories that you’re likely 
to want, such as office/stu-
dio equipment, tech gad-
gets, audio/video, and gen-
eral lifestyle products.

Free Rare Books 
on Calligraphy and 
Penmanship
If you enjoy hand-lettered 
artistry of the pen-and-ink 
variety, you’ll like the col-
lection at  
www.iampeth.com/books.php. 
They scanned a number of 
old books on penmanship 
and calligraphy and post-
ed them in PDF format. 
Treat yourself to a look.
If you just want to see 
some incredible examples 
of penmanship, calligra-
phy, and legal proclama-
tions, see  
www.iampeth.com/artwork.php.

Worth Reading

A Guide to Using 
Images Ethically
Mike Rankin points out 
an infographic guide to 
the benefits of using online 
images with Imgembed 
versus using images with-
out permission. The info-
graphic details the steps 
involved in both approach-
es and shows how doing 
the right thing and do-
ing the easy thing are often 
same. See it at  
www.tinyurl.com/mup6ngu.

Are You Getting the 
Most Out of EPUB 3?
Bill Kasdorf wrote a re-
markably helpful intro-
duction to EPUB 3, the 
new standard format for 
electronic books and oth-
er publications. His story 
includes a bunch of help-
ful resources for checking 
your EPUB files and see-
ing examples of good ones, 
plus a list of which features 
of EPUB 3 are current-
ly supported by each read-
ing system and a best prac-
tices book. Read it at at the 
Book Business website at 
www.tinyurl.com/n8quncu.

BLAG: Excellent Mag 
Uses App Studio
BLAG is a creative, inspir-
ing, free publication creat-
ed using the new App Stu-
dio. Get the latest edition 
at www.tinyurl.com/l2ofdwd.  
Read more about it at  
www.planetquark.com/?p=8851.

Another example of a free 
magazine that uses App 
Studio is VIEW Magazine. 
Read more about it at  
www.tinyurl.com/l9kn726 or 

Store) is an app that allows 
you to—almost literally—
let the creativity flow from 
your fingers. Type words, 
phrases, or full text into 
the app and then use your 
finger to draw with those 
words. The speed at which 
you draw controls the size 
of the text you create. 
You can choose and con-
trol opacity, colors, and 
tracking; pick from 51 
fonts; zoom and pan; and 
export to JPEG, high-res 
PNG, or scalable PDF. Us-
ers report creating inter-
esting watermarks and 
creating typographic art 
using this app and have 
uploaded videos of works 
in progress to the online 
users gallery.

Get Inspiration  
On the Go
If you’ve ever had a hard 
time starting a project be-
cause you just weren’t feel-
ing inspired, DesignScene 
for the iPad might become 
your new best friend. 
Whereas most apps fo-
cus on one presentation 
style, DesignScene focus-
es on one topic—design 
of all kinds—and presents 
the results in photograph-
ic and textual format. It’s 
part photostream and part 
RSS reader, delivering in-
spiration from the worlds 
of architecture, fashion, 
photography, typography, 
and art right to your iPad. 
Once you’ve found some-
thing that’s inspired you, 
you can use the built-in 
browser to explore further 
or share with your fellow 
designers via e-mail, Face-
book, or Twitter. Get it at 
www.tinyurl.com/mx59ljc.

Software (from pg. 5) Websites

Instant Oil Spill
Here’s a clever trick using 
Flash that generates a fake 

“oil spill” on any website 
you point it to:  
www.instantoilspill.com. It was 
developed by Mark & Phil 
as a promotional piece.

The Public Domain  
Review
Mike Rankin wrote about 
The Public Domain Re-
view, a website that fea-
tures curated collections 
of images, text, audio, and 
video in the public domain 
that you can use in any 
way you like, including 
commercial projects. The 
website also has a guide to 
finding interesting public 
domain materials online, 
with links to large collec-
tions of open content and 
explanations of licensing 
and legal issues. Read his 
story at  
www.tinyurl.com/mszm69f.

www.typophile.com
Way into fonts? Check out 
www.typophile.com. It has 
news about font events, 
font developers, books, 
free fonts, and enlighten-
ing discussions.

Temporary Tattoos  
for Creatives
Tattly has a collection 
of fun, artist-contribut-
ed temporary tattoos with 
a designy flair. The tem-
porary tats—which range 
from the bold “Type Nerd” 
or “Beziér Girl” designs to 
the subtle “TATTONE 5K1 
N” swatch—are $5 for a set 
of two. If you’re looking 
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download VIEW at  
www.tinyurl.com/loazq7e.

How to Create 
Beautiful Tables
James Felici wrote a won-
derful three-part series 
called “How to Create 
Beautiful Tables.” He ex-
plains how to control spac-
ing, use styles, work with 
rules, align numbers, and 
more.
Read them at  
www.tinyurl.com/klgdjyu,  
www.tinyurl.com/myzpenh, and 
www.tinyurl.com/ksvedb3.

FREE Official 
QuarkXPress Training 
Materials
If you are just beginning 
with QuarkXPress or look-
ing for best practices and 
new features, be sure to 
check out Quark’s QuarkEd 
Training Modules.
Each free module contains 
a PDF guide as well as all 
of the supporting sample 
files you’ll need to com-
plete the module.
Module 15 (“Digital Pub-
lishing”) is especially help-
ful. Get them all at  
www.tinyurl.com/7u4evry.

Web App versus  
Native App?
What are the advantages 
and disadvantages of pro-
ducing your digital publi-
cation as a Web app or as 
a native app (i.e., one that 
runs in any Web browser 
versus one that runs only 
on iOS, Android, etc.)? 
There’s a good chart that 
shows when to use each 
approach at  
www.tinyurl.com/p7gra7c.

Note that solutions such as 
App Studio can produce 
both kinds of apps from 
the same source. Visit  
www.appstudio.net.

InDesign Magazine
InDesign Magazine is the 
premiere source of infor-
mation about Adobe In-
Design. It’s published ev-
ery two months, and each 
beautiful, insightful issue 
contains extremely valu-
able information about us-
ing InDesign. A two-year 
subscription (12 issues) 
costs $89, while a one-year 
subscription (6 issues) costs 
$59. When you subscribe, 
you can also download all 
their back issues for free!
Learn more at  
www.indesignmag.com.

Color Theory  
on Your iPad
Interaction of Color, Josef 
Albers’ influential book on 
color theory, has just been 
released as an iPad app. 
This publication has been 
used in classrooms for 
over 50 years, and the iPad 
version brings back the in-
teractivity that the original 
box set offered. 
The free version of the app 
contains one chapter and 
includes access to some of 
the special features (such 
as the color palette tool), 
but the full version ($9.99, 
in-app purchase) has vid-
eo interviews, interactive 
studies, and over 125 col-
or plates along with the 
full text. 
The app also offers exer-
cises in color theory, in-
cluding the ability to cre-
ate your own palettes and 
share them in .svg format 

through email, Facebook, 
or Pinterest. Get it at  
www.tinyurl.com/q5akwxr.

Megapixels and 
Maximum Print Sizes
Still confused by megapix-
els and how a camera’s al-
location of those megapix-
els will affect printed im-
age quality? Design215’s 
free Megapixels Chart 
helps to clear up confusion 
by graphically display-
ing how many megapix-
els an image needs to print 
well at 300 ppi at different 
sizes. Another chart dis-
plays the maximum print 
size—for 300, 200, and 150 
ppi prints—in relation to 
megapixels. If you want 
the über-geeky explana-
tions of why and how, that 
information is also includ-
ed. Get it at  
www.tinyurl.com/y9xnvw.

Becoming  
a Graphic Designer
Whether you’re looking to 
expand your graphic de-
sign career into new areas 
or you know a young per-
son who is interested in 
becoming a designer, this 
book will provide tremen-
dous insight and inspira-
tion: Becoming a Graph-
ic Designer, 4th Edition, by 
Steven Heller and Teresa 
Fernandes. 
The first part describes 10 
different design special-
ties, then they describe the 
various forms of design 
businesses, and then they 
move into the fuzzy areas 
of crossing disciplines. Fi-
nally, they cover the var-
ious ways to get a design 
education. Throughout the 
book are insightful inter-

views with successful de-
signers. $40 from Wiley.

Use Preview  
to Annotate PDFs
Mac users have a valu-
able PDF editor and an-
notator included with OS 
X. The Preview app can 
do much of what people 
buy Acrobat for—you can 
add bookmarks, rearrange 
pages, add comments, 
highlight items, add signa-
tures, and much more!
Read Chris Breen’s story at 
www.tinyurl.com/mwff5o7.

Videos

InDesign Secrets
David Blatner and Anne-
Marie Concepción’s ongo-
ing video series, InDesign 
Secrets, provides dozens of 
useful tips and productiv-
ity boosters, such as how-
tos on creating bookmarks 
for PDFs and fixing short 
last lines. Updated every 
other week, this collection 
also covers helpful scripts 
to make your work fast-
er and easier. Currently in-
cludes nine hours of video; 
available at Lynda.com.

www.lynda.com

Typography 
Foundations
For a crash course on ty-
pography basics, check 
out the Foundations of Ty-
pography course from Ina 
Saltz. Including every-
thing from kerning and 
tracking to trends in ty-
pography, this video train-
ing is a good introduction 
for a beginner or refresh-
er for a designer. 2.5 hours, 
from Lynda.com.

www.lynda.com
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er style to the current lay-
er. (Their animated logo is 
reason enough for visiting 
their website at  
www.tinyurl.com/mljo4ux).

MirrorMe Plug-in  
for Illustrator
Illustrator’s Reflect tool is 
limited to reflecting along 
one axis at a time, but the 
new MirrorMe plug-in from 
Astute Graphics (£39+VAT, 
approximately $61) gives 
you full control over axes—
up to 72 at once!—and the 
option to view the results in 
real time. 
This plug-in lets you 
quickly create more intri-
cate drawings with com-
plex effects, and a free trial 
is available to see if it’ll be 
useful in your workflow.

www.astutegraphics.com

Best-selling 
Productivity Plug-ins
Here are the best-sell-
ing productivity plug-ins 
for QuarkXPress and In-
Design, as compiled by  
www.ThePowerXChange.com. 
“Automation is the Future!”

QuarkXPress:
BlackLining for QXP 9
CopyFlow Gold for QXP 8/9
MadeToPrint XT for QXP 9
Math Grabber for QXP 9
Sonar Bookends for QXP 
8/9
Xcatalog Pro for QXP 8/9
Xdata for QXP 8/9

InDesign:
CtrlChanges Pro for ID & 
InCopy CS6
CopyFlow Gold for ID CS6
InData for ID CS5/CS6
InCatalog Pro for ID CS5/6
MadeToPrint for ID CS6

Plug-Ins

Most of these plug-ins & 
XTensions are available at:
The PowerXChange

(877) 940-0600 
www.ThePowerXChange.com

XChange International
www.XChangeUK.com

Quick Repairs  
with SnapHeal Pro
MacPhun’s SnapHeal Pro 
($40; $20 upgrade) is an 
upgrade to the original 
SnapHeal, which provides 
content-aware fill and ad-
vanced image adjustments 
without requiring Photo-
shop. 
SnapHeal Pro can be used 
as a standalone app or as a 
plug-in to Photoshop, Pho-
toshop Elements, Light-
room, or Aperture. Besides 
cleanly removing objects 
from an image, it also can 
improve gamma, satura-
tion, contrast, temperature, 
sharpness, noise, and shad-
ows and highlights. It also 
has a scratch repair mode. 
The examples on their 
website are impressive!

www.macphun.com

Subtle Patterns  
in Photoshop
The Subtle Patterns Photo-
shop plug-in ($12) makes 
attractive, muted patterns 
accessible from within a 
Photoshop panel. Through 
this panel, you’ll have con-
stant access to the entire 
SubtlePatterns.com library, 
which currently includes 
over 300 patterns. 
Accessing them is easy—
select a pattern in the pan-
el, and the plug-in will au-
tomatically add it as a lay-

Output Factory
Sonar Bookends InDex 
Pro for ID
vjoon Overset Manager v9 

www.thepowerxchange.com

FrameReporter  
for InDesign
Rorohiko’s FrameReporter 
plug-in for InDesign ($39, 
free trial available) gives 
you details on the content 
of image or text frames, 
without you having to visit 
several different panels. 
Running the plug-in puts 
labels next to image and 
text frames in your doc-
ument with information 
such as file name and file 
path, effective resolution, 
overset text, word count in 
the frame, and master page 
overrides. The info is all 
contained on its own layer, 
so you can easily hide the 
info frames.

www.rorohiko.com

Knoll Light Factory 3
Digital Anarchy’s Knoll 
Light Factory 3.0 ($149) 
goes beyond Photoshop’s 
limited light flare feature 
by offering more than 100 
different light and flare 
presets. 
The plug-in includes 17 
different elements for each 
preset that can be com-
bined in any way to pro-
duce striking and dramat-
ic lighting effects. In addi-
tion to sci-fi–style effects, 
it can also create photore-
alistic lens flares and other 
lighting enhancements.

www.digitalanarchy.com

Create “Drop Words” 
in InDesign
In-Tools’ Drop Words ($39) 
is a plug-in for InDesign 
that provides fine control 
when creating Drop Words 
(similar to Drop Caps, but 
longer). Common in He-
brew typesetting, Drop 
Words can be defined by 
number of words or by 
special character delimit-
ers, with control over num-
ber of words. Styles can au-
tomatically be applied to 
Drop Words as well.

www.in-tools.com

InDihyph
If you need super control 
over hyphenation in In-
Design, the built-in tools 
might not be enough. The 
InDihyph plug-in from 
i.t.i.p. boosts hyphenation 
control using advanced al-
gorithms, allowing it to 
“think” how to best hy-
phenate even the most dif-
ficult compound or new 
words. 
The plug-in gives you tight 
control with five different 
hyphenation quality lev-
els and allows you to cre-
ate exception rules for cus-
tom hyphenation. One bo-
nus feature of InDihyph is 
the ability to remove dis-
cretionary hyphens from 
imported text. The plug-in 
supports multiple languag-
es in InDesign and InCopy.

www.tinyurl.com/m3zavgk

Automatic  
Cross-References
If you work on documents 
that use cross referenc-
es, consider Virginia Sys-
tems’ Sonar Bookends Xref 
for QuarkXPress or InXref 
for InDesign ($195). With 
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Fonts

…from FontSpring.com
Veneer from Yellow De-
sign Studio is a high-res-
olution, hand-crafted let-
terpress font that’s vintage 
and authentic with a touch 
of grunge. It’s highly cus-
tomizable, with six distress 
options for every letter and 
three for all other charac-
ters, and because it’s re-
markably detailed, it looks 
great even at very large siz-
es. In addition, it includes 
a matching set of funky 
extras…for free!

The Veneer family includes 
Veneer, Veneer Two, and 
Veneer Three, with Veneer 
containing the least-dis-
tressed characters and Ve-
neer Three the most. Get 
the free Veneer Extras font 
at www.tinyurl.com/kbfw4sa.

…from FontShop
Erler Dingbats is a free 
OpenType subset of Font-
Shop’s giant FF Ding-
bats collection, with 17 
new glyphs. Originally de-
signed as an updated ver-
sion of Zapf Dingbats, the 
collection of arrows and 
circled numbers are espe-
cially useful! For lots more 
information and to down-
load, check out  
www.tinyurl.com/lpkn87g.

Font Identifiers
In the past, we’ve men-
tioned some free online 
tools that help you identify 
a font from a sample, like  
www.tinyurl.com/kn2cqs9,  
www.identifont.com, and the 
WhatTheFont feature at 
www.MyFonts.com (which also 
has a free iPhone app!). 
Here’s another:  
www.whatfontis.com. 
One nice feature is that 
you can tell it to list only 
free fonts, commercial 

fonts, or both. Also useful 
is that it provides a long 
list of alternate fonts, so if 
you have a font you like, 
but you want a slightly dif-
ferent one, you may find 
an acceptable option in the 
list of results.

The Best  
Type Book Creator
Veenix Software’s Type-
Book Creator ($50) is the 
best program we’ve seen 
for printing type speci-
mens or books (and we’ve 
seen them all!). 
You can print samples of 
active or inactive fonts, in 
any of 16 classic layouts, 
and customize the text 
used in the samples. It can 
even categorize your fonts 
for you and then help nar-
row down your font choic-
es by serif, sans serif, text, 
condensed, expanded, 
monospaced, shadow and 
3D, and more. 
Download the demo and 
see what we mean.

www.veenix.com

Adios Script Pro
Alejandro Paul’s script is 
a technically intricate font 
bursting with advanced 
OpenType features.
Inspired by lettering artist 
H. Wotzkow, not to men-
tion contemporary tattoo 
art, Adios has a profusion 
of ornamental ascenders 
and descenders that allow 
extraordinary variety. The 
lowercase “h” alone of-
fers 43 variants; the entire 
font has a staggering 1,470 
glyphs.
Watch the slideshow of 
amazing examples in use at 
www.tinyurl.com/ld6r34.

Your Handwriting as a 
Font for $9
For just $9, www.fontifier.com 
will convert your hand-
writing to a font. You write 
your characters on a tem-
plate they supply, scan it, 
and upload it to their web-
site. After previewing the 
result, you can pay for and 
download your font.  
Another website,  
FontCapture.com, per-
forms a similar service for 
$9.95.

…from Fonts.com
Baron Of Arizona: 

FontCase: Simple  
Font Management
Bohemian Software’s Font-
Case ($30) brings Mac sim-
plicity to font manage-
ment. Fonts are arranged 
by genres or user-creat-
ed collections and all fonts 
in a group. Each font can 
be displayed in display or 
body copy, or simply as 
a set of glyphs, which in-
cludes easy copying of 
HTML code for each glyph. 
There is also an iOS com-
panion app (99¢) that lets 
you view your chosen Font-
Case fonts on your mo-
bile device for side-by-side 
viewing and comparison. 
FontCase even allows you 
to try out different fonts in 
an existing Web page by 
simply dragging and drop-
ping fonts into the built-in 
Typesetter window.

www.bohemiancoding.com

it, you mark anything in 
a document, such as a ta-
ble, figure, or photo, and 
then refer to its page num-
ber elsewhere in the docu-
ment. If the item moves, its 
page number reference up-
dates automatically.

www.virginiasystems.com

Output Pages as 
Separate EPS or 
PostScript files
MPS Page Printer ($125) is 
a plug-in for InDesign or 
an XTension for Quark-
XPress that lets you out-
put each page or spread of 
a document in EPS or Post-
Script format. 
For EPS output, Quark-
XPress users have the op-
tion of embedding fonts 
within the EPS files. It pro-
vides numerous options for 
specifying how the result-
ing files should be named, 
supports discontiguous 
page range selection, and 
lets you set up separate op-
tions for single versus mul-
tiple page documents.

www.meadowsps.com
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Tips (from pg. 1)

ing what you make, think-
ing bigger, and managing 
stress and optimizing en-
ergy.
Their system is clever—
you can watch the work-
shops live for free, but if 
you want to rewind, fast-
forward, or watch por-
tions at another time, you 
must purchase a record-
ing of the event. (They also 
broadcast each workshop 
for free on the night af-
ter the workshop for those 
in other time zones.) Most 
recordings cost $39–$99. 
Sign up for their an-
nouncements and keep 
checking their calendar at 
www.creativelive.com.

Mission Accomplished
You can use the Mac’s 
built-in Mission Control 
feature to sequester appli-
cations on separate “desk-
tops” so your workspace 
will be clutter-free. Build-
ing on older technologies 
like Exposé and Spaces, 
Mission Control is a fea-
ture of both OS X 10.7 and 
10.8; access it by hitting F3 
or fn-F9 on your keyboard 
or by clicking on its icon 
in your Dock (it looks like 
a square with three small 
app windows in it). 
Once the interface opens, 
create a new desktop by 
dragging your mouse to 
the upper-right corner to 
reveal a plus button. After-
ward, drag any application 
or window to your new 
desktop, and then you can 
move between desktops by 
pressing Control-Right Arrow 
and Control-Left Arrow. For 
more info:  
www.tinyurl.com/n3hvep7

Back Up  
Time Machine Disks
Time Machine is a terrif-
ic tool for backing up your 
files throughout the day, 
but you can’t easily cre-
ate a backup of your Time 
Machine drive. For that 
we recommend Carbon 
Copy Cloner ($40) from 
Bombich Software. It can 
make an exact duplicate of 
your Time Machine back-
up disk, so if it fails you 
still have a copy of its con-
tents. Carbon Copy Clon-
er lets you restore the copy 
of your backup, too, so you 
can get Time Machine up 
and running again quickly 
if its hard drive should fail. 

www.bombich.com

Password-Protect  
Mac PDFs
For a simple way to pass-
word-protect PDFs on your 
Mac, use the built-in Pre-
view application. Open the 
PDF (or other file) in Pre-
view, then choose File> Ex-
port. In the dialog box that 
appears, click on Encrypt, 
type in your desired pass-
word, and click Save. If you 
don’t change the name or 
location of the file, the ex-
isting one will be overwrit-
ten with your password-
protected version.

Scroll Direction Switch
Hate the way that OS X 
10.7 and 10.8 swapped the 
scroll direction for track-
pads? You can change it 
back. 
Just go to System Preferenc-
es> Trackpad, click on the 
Scroll & Zoom tab, and tog-
gle off “Scroll direction: nat-
ural.” (Adjusting a gesture-
enabled mouse instead? 

The setting’s within System 
Preferences> Mouse under 
the Point & Click tab.)

Talk to Your Mac
If you’d like to use dic-
tation on your Mac run-
ning OS X 10.8, turn it on 
within System Preferenc-
es> Dictation & Speech un-
der the Dictation tab. Then 
place your cursor where 
the text should go and 
tap the Function (fn) key 
twice. When you’re fin-
ished speaking, tap the 
Function key or the Return 
key, or click the Done but-
ton. It takes some prac-
tice, but you can even in-
clude punctuation (“I will 
see you tomorrow comma 
John exclamation point”).

Check Laptop  
Battery Capacity
Periodic battery calibra-
tion is important to get the 
most out of your laptop’s 
battery, but determining a 
battery’s health isn’t exact-
ly intuitive. However, co-
conutBattery (free in this 
month’s Software Closet) 
lets you see its maximum 
charge capacity, current 
charge, the maximum ca-
pacity when your battery 
was new, the number of 
times it’s been recharged, 
and more. If your max-
imum charge is around 
1,000 mAh less than the 
original capacity, it’s prob-
ably time to recalibrate 
your battery. Here’s how:
•	 Fully charge your battery.
•	 After fully charging, keep 

power connected for a 
few hours.

(The following part is best 
done at the end of a work 
day.)

•	 Disconnect the power 
adapter and allow your 
system to run from the 
battery until it enters 
sleep mode because of 
a low battery. Playing a 
video will help drain the 
battery more quickly.

•	 Let your Mac sleep for at 
least five hours.

•	 Reconnect the power 
adapter and allow your 
Mac to fully charge.

If recalibrating doesn’t re-
store your battery’s life, 
it may be wearing out. If 
that’s the case, it’s time for 
a new battery.

Serial Number Decoder 
for Macs
To learn more about your 
Mac or about a used one 
you are considering pur-
chasing, Chipmunk In-
ternational has a free on-
line service that tells you 
the model name, produc-
tion factory, year and week 
it was built, info on prod-
uct recalls, and more. The 
Web form works with all 
Macs (although it works 
best with older models) 
and other Apple prod-
ucts such monitors, print-
ers, and laptop batteries. 
We found that one of our 
MacBook Pros was manu-
factured in Shanghai dur-
ing the 49th week of 2010. 
Try it for yourself at  
www.tinyurl.com/c49o7.

Your Designs, on Wine
Before your next celebra-
tion, check out the amaz-
ing custom-etched wine 
bottles from EtchingX. 
While they offer dozens of 
pre-made designs for hol-
idays, graduations, and 
other occasions, you can 
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also upload your own art-
work for a truly original 
gift. Prices on their pre-
designed bottles average 
about $75, with more ex-
pensive wine and spirits 
available for an additional 
cost. For a quote on a cus-
tomized bottle, fill out the 
inquiry form at  
www.tinyurl.com/ospvcjd.

Earth Class Mail
Earth Class Mail is a phys-
ical (USPS) mail box ser-
vice. But they scan your 
mail, archive it, and recy-
cle it, so you can view it 
from anywhere. Great for 
people who travel or have 
to move frequently. Starts 
at $10/month:  
www.earthclassmail.com

Halloween  
Bottle Labels
With these Halloween 
Wine Bottle Stickers by 
Morbid Enterprises, you 
can transform a ho-hum 
bottle of wine into Spider 
Venom, Embalming Juice, 
or Rat Poison. The pack-
age includes eight labels 
in four styles to fit stan-
dard liquor bottles. Check 
them out:
www.tinyurl.com/mepzszr

www.tinyurl.com/mgkbsz5

www.tinyurl.com/mvrj27c

www.tinyurl.com/lmlskzm

Acrobat: Replace 
versus Insert Pages
When replacing pages in 
a PDF, if you use the Re-
place command, any non-
printing data such as hy-
perlinks, bookmarks, and 
comments are retained 
from the old page to the 
new page. Usually, this is 

a better choice than delet-
ing the pages and inserting 
new ones. 
To replace pages visual-
ly, open the Pages pane, se-
lect the thumbnails for the 
pages you want to replace, 
and choose Options> Replace 
Pages from the menu in 
the Pages pane. To replace 
pages numerically, choose 
Replace Pages… from the 
Document menu in the 
menu bar.

Try OCR in Acrobat
Acrobat has become a jack 
of all trades, with many 
unexpected features. For 
example, it supports OCR 
(Optical Character Recog-
nition). Recent versions let 
you scan a document from 
within Acrobat (or open a 
scanned document) and 
then invoke the text-recog-
nition feature. In Acrobat 
9, choose Document> OCR 
Text Recognition; in Acro-
bat X and above, open the 
Tools panel and choose 
Text Recognition.
Beginning with Acrobat 9, 
OCR is vastly improved—
we tried it on a 72 ppi scan 
of the back of a CD cov-
er, and it worked remark-
ably well.
It can even recognize text 
in multiple PDFs at the 
same time, and Acrobat’s 
dictionary can help you 
find words that were im-
properly recognized by 
OCR. Just click Find First 
Suspect in the Text Recog-
nition panel to correct the 
mistakes.

Use Fill Layers Instead
When building regions of 
color on a series of layers 
in Photoshop, use solid-

color fill layers instead of 
the standard image layers. 
To do it, choose Layer> New 
Fill Layer> Solid Color, or use 
the half-black/half-white 
icon (the adjustment lay-
er menu) at the bottom of 
your Layers panel. 
The color of fill layers can 
be changed easily by dou-
ble-clicking their lay-
er thumbnails. They also 
scale automatically if you 
resize your canvas, which 
can be handy.

Show Overprinting and 
Rich Blacks in Acrobat
Adobe Acrobat Pro has a 
feature that highlights the 
portions of your image 
that are set to overprint or 
print as rich blacks. To get 
to it, do this:
In Acrobat X and higher:
Choose View> Tools> Print 
Production. In the Print 
Production panel, choose 
Output Preview.
In the resulting Output 
Preview dialog box, turn 
on the Simulate Overprint-
ing option.
From the Preview popup 
menu, select Color Warnings.
In the Warnings section, 
turn on the Show Overprint-
ing and Rich Black options.
By default, overprinting 
objects appear in yellow 
and rich black objects in 
blue-green. If those col-
ors blend into your design, 
you can adjust the color of 
the warnings by clicking 
on the swatches located to 
the right of each checkbox.
In earlier versions of 
Acrobat:
Choose Print Production> 
Output Preview and turn on 
the Simulate Overprinting 

option. In the Preview sec-
tion of the resulting dialog 
box, select Color Warnings. 
In the Warnings section, 
turn on the Show Overprint-
ing and Rich Black options.

Using Adjustment 
Layer Presets
In addition to freeing the 
power of adjustment layers 
from a static, modal dialog 
box (via the Adjustments 
panel), Photoshop supports 
the loading and saving of 
adjustment layer presets 
like Levels, Curves, Hue/
Saturation, and Selective 
Color. (You can select these 
options from the Adjust-
ment panel’s fly-out menu.) 
The preset files are very 
small and easily distribut-
ed; to share your own, copy 
the corresponding file 
from the Preset folder (in-
side the Photoshop applica-
tion folder) and pass it on.

John Nack

Using Pantone Colors 
on Inkjet Prints
Let’s say you want to use 
a specific Pantone color 
in your artwork in Pho-
toshop, but you’ll be out-
putting to a printer that 
can’t actually print that 
spot color (such as an ink-
jet printer). What should 
you do? Click on your 
Foreground color swatch 
to open the Color Picker, 
then click on the Color Li-
braries button, select your 
spot color, and click OK. 
Photoshop automatical-
ly selects the nearest RGB 
(or CMYK or Lab) equiv-
alent of that Pantone color, 
and you can paint, fill, or 
stroke using the new Fore-
ground color. 
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Already have a spot chan-
nel? Click on it in the 
Channels panel and then 
select Merge Spot Channel 
from the Channels panel’s 
flyout menu.� Peter Bauer

Tricks to Control New 
Document Sizes in 
Photoshop
•	 If you need a new Photo-

shop document the same 
size as a document you 
already have open, do 
this: Start to create a new 
document (File> New), 
and then select the name 
of any open document 
from the Window menu 
on Photoshop’s menu 
bar—which is still mirac-
ulously available.

•	 If you create a new docu-
ment in Photoshop while 
you have something on 
the clipboard (for exam-
ple, if you have copied 
something from an exist-
ing document), your new 
document will be sized 
to fit the pixels on the 
clipboard.

•	 To make a new docu-
ment the same size as the 
last new document you 
created, hold down the 
Option key while you 
choose File> New.

Using Photoshop’s 
Smart Guides
Smart Guides differ from 
regular guides in that they 
automatically appear when 
necessary to show the spa-
tial relationship between 
objects—meaning they 
show when objects are 
aligned or evenly spaced 
in your document. 

As you drag an object, 
Smart Guides appear 
whenever the current ob-
ject is horizontally, ver-
tically, or center-aligned 
with other objects on oth-
er layers. To enable Smart 
Guides, choose View> Show> 
Smart Guides. 
Photoshop will then alert 
you with a thin red line 
any time you approach the 
boundaries of another lay-
er so you know if you’re 
about to move past the 
edge of other layers. Smart 
Guides are extremely help-
ful when you’re manu-
ally aligning layers with 
the Move tool, since they 
make it easier to precisely 
position layers in relation 
to each other.

Lesa Snider, www.PhotoLesa.com

Undo Saves  
in Photoshop
In Photoshop, you can use 
the History panel to get 
back to your original im-
age, even after you’ve re-
saved it. 
To recover an original im-
age after you’ve saved over 
it, just click the open-
ing snapshot in the His-
tory panel (or press Com-
mand-Option-Z to step back 
through the History panel 
until you get to where you 
want). 
You can then create a new 
document from that state 
by clicking the button at 
the bottom of the Histo-
ry panel named “Create 
new document from cur-
rent state.” 
Second tip: To step for-
ward through the Histo-
ry panel, press Command-
Shift-Z.

Let Illustrator  
Do the Walking
Illustrator can automat-
ically expand the Layers 
panel and scroll to a select-
ed object within hidden 
layers. Just select an object 
in your artwork and click 
the Locate Object icon in 
the Layers panel. For more 

“new feature” tips:  
www.tinyurl.com/bo2u7d

Sharon Steuer,  
Illustrator WOW! Book

Illustrator’s Gradient 
Libraries
When building gradients 
in Illustrator, it’s helpful to 
remember that Adobe in-
cludes a library of Gradi-
ent Libraries you can start 
with. In the Swatches pan-
el, click on the Swatch Li-
braries menu and choose 
Gradient. You can then 
choose among 21 gradient 
swatches to add!

Access InDesign’s 
Find/Change History
InDesign remembers every-
thing you’ve ever entered 
into its Find and Change 
fields. (That is, everything 
since you last rebuilt your 
preferences.) To access your 
Find/Change history, open 
Find/Change and click on 
the up/down arrow icon 
immediately to the right of 
either field. 
Don’t go all the way to 
the right; those are the 
metacharacter drop-down 
menus. Find/Change histo-
ry can be useful when you 
need to run the same Find/
Changes in a series of lay-
outs.�

Anne-Marie Concepción,  
� InDesignSecrets.com

Outputting Multiple 
Layouts in InDesign
At InDesignSecrets.com, 
Steve Werner explains ex-
actly how to print or ex-
port any combination of 
pages in InDesign, even if  
they are in different sec-
tions, layouts, or alternate 
layouts. Highlight: “You 
just need to enter the full 
name of the layout, fol-
lowed by a colon, followed 
by page number(s).” Read 
all about it at  
www.tinyurl.com/mcwbnvl.

10 Essential Tips  
for InDesign
Plucked from the pages of 
InDesign Magazine, “10 Es-
sential Tips for InDesign” 
is worth reading at  
CreativePro.com:  
www.tinyurl.com/n4dtrzu

Smart Guides  
in InDesign
The Smart Guides fea-
ture in InDesign is so bril-
liant it should be in all lay-
out apps. To use it, choose 
View> Guides & Grids. Then, 
as you drag an object on 
your page, a guide will ap-
pear when that object is 
aligned with another ob-
ject or group—top, bottom, 
left, right, or center. 
If there are multiple items 
on the page that are al-
ready aligned and dis-
tributed, a guide will ap-
pear when your new ob-
ject is at the same distance 
from them as they are 
from each other. (In other 
words, when the new ob-
ject is in the proper loca-
tion to join the others in a 
distributed set.)
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Use Negative Text 
Wrap in InDesign
If you want text to follow 
the shape of an object in 
InDesign while also over-
lapping the object, enter 
negative values in the Text 
Wrap panel.

Erica Gamet, InDesign Magazine

Replace a Graphic  
in InDesign
In InDesign, you can load 
your cursor with one or 
more graphics, and then 
use the Up and Down Ar-
row keys on your keyboard 
to scroll through the graph-
ics in the loaded cursor. 
But here’s the tip: If you 
want to replace a graph-
ic already on the page with 
the picture in your loaded 
cursor, just hold down the 
Option key when you click 
on the existing picture. It 
will be replaced with the 
graphic from your cursor.

Scale Frame and 
Content in InDesign
To scale a frame, along 
with the image inside, 
from five inches to three 
inches wide, you can use 
the Scale X and Scale Y fields 
in the Control panel to 
scale both simultaneous-
ly. However, you have to 
do the math because the 
Scale X and Scale Y fields 
use percentages by default. 
To skip the math, simply 
enter “3 in” into the Scale 
X field and press the Enter 
key instead.

Skip the  
“New Document” 
Dialog Box in InDesign
To bypass the New Docu-
ment dialog box when cre-
ating a new InDesign doc-
ument, add the Option key 
to the Command-N key-
board shortcut. The result-
ing new document will 
be based on whatever set-
ting you last chose in the 
Document Preset pop-up 
menu in the New Docu-
ment dialog box.

Spellcheck 
Capitalization  
in InDesign
Select the Case Sensitive 
option when you enter a 
word into a spelling dic-
tionary (Edit> Spelling> User 
Dictionary) if the word 
you’re adding is a trade 
name, proper name, or a 
word with intercaps, such 
as “InDesign.” This way, if 
the word is used in your 
document with improp-
er capitalization, it will be 
flagged as a spelling error.

Keith Gilbert, InDesign Magazine 

Smart Text Reflow  
in InDesign
InDesign has the ability to 
automatically add and re-
move pages when the text 
in threaded text frames in-
creases or decreases. It re-
quires that you already 
have two or more pages in 
your document, and by de-
fault it only applies when 
you’re using the text frames 
that exist on master pages. 
To modify the behavior so 
Smart Text Reflow applies 
to text frames you cre-
ated on document pages, 
choose InDesign> Preferenc-
es and turn off the Limit to 

Master Text Frames check-
box in the Smart Text Reflow 
section.

Merge Color Swatches 
in InDesign
If you have two color 
swatches in InDesign that 
should be the same, you 
can merge one into the 
other. In the Swatches pan-
el, select the one you want 
to keep, then select the 
other one (Command-click 
to select multiple swatches). 
Then choose Merge Swatches 
from the Swatches panel’s 
flyout menu.

Use Quick Apply  
to Quickly Edit Styles
InDesign’s Quick Apply 
feature does more than 
just allow you to apply 
styles. For example, press 
Command-Return to open 
the Quick Apply pan-
el. Then type as many let-
ters as necessary to get to 
the name of a specific style. 
However, instead of press-
ing the Return key, press 
Command-Return again, and 
you’re now in the Style 
Options dialog box for 
that style! Make your ed-
its and then close the dia-
log box to change the Style 
definition.

Sandee Cohen, InDesign Magazine

Two Places to Lock 
Guides in InDesign
If you try to move a guide 
in InDesign, but it seems 
locked, and yet there is 
no checkmark next to 
Guides> Grids and Guides> 
Lock Guides, have a look at 
its Layer options (in the 
Layers panel menu> Layer Op-
tions). When the guides 

are locked in the Layers 
panel, the View menu may 
not reflect that lock.

Sandee Cohen, InDesign Magazine

Make an  
Image Sandwich
David Blatner explains 
how to make part of an 
image pop out and over a 
logo or text (for example, 
for a magazine cover) at  
www.tinyurl.com/mawjjpp.

He uses InDesign, but the 
same technique works in 
QuarkXPress.

Touch to Select Items
In both InDesign and 
QuarkXPress, the fast-
est way to select multi-
ple items is to drag a selec-
tion marquee that touch-
es the items you want to 
select. You don’t have to 
completely surround an 
item—just touching it will 
add it to the selection. Use 
the Selection tool (ID) or 
the Object tool (QX) for 
this task.

Drop Cap Tips 
for InDesign and 
QuarkXPress
At CreativePro.com, Jim 
Felici wrote two stories 
about the ins and outs of 
creating, positioning, and 
using drop caps in In-
Design and QuarkXPress, 
including how to create 
partially dropped caps and 
the best way of dealing 
with descenders. 
They’re available at  
www.tinyurl.com/mtgvsce and 
www.tinyurl.com/mcljgak.

…more Tips & Tricks on page 16
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Helpful Utilities
coconutBattery 2.8
coconutBattery (free) displays important data about your 
laptop’s battery, such as its maximum charge capacity, its 
current charge, and its original maximum capacity when the 
battery was new. It also gives the age of the laptop and how 
many times your battery has been fully charged.

Free Graphics & Documents
Free Vector Patterns
David Blatner is offering 20 of his custom-made patterns 
for free download as PDFs at CreativePro.com. The patterns 
are large enough to fit an A4- or letter-sized page and can 
be placed as PDFs in InDesign, Illustrator, or Photoshop or 
opened in Illustrator to edit the vector objects. Some of the 
patterns are repeating, while others appear to radiate, twirl, 
or pulsate. Check them out at www.tinyurl.com/lxydh8c.

InDesign Goodies
Calendar Wizard for InDesign
Anyone who has had to create a calendar in InDesign—or an 
ongoing series of them—knows how time consuming they 
can be. 
One solution is Scott Selberg’s free Calendar Wizard script 
for InDesign, which features a robust interface that lets you 
choose how many months to display and pick date ranges, a 
day to start on, and calendar orientation. In addition, there 
are several holiday lists to auto-populate your calendars 
and several custom layers choices, such as those for day of 
the year, background picture, and phases of the moon. The 
beauty of the script package lies in the additional script 
that re-fits the calendar to a frame (even when the frame is 
resized) and the use of paragraph styles for easily updating 
calendar text. Get it at www.tinyurl.com/p5zedsh.

For other options, see Sandee Cohen’s story at  
www.tinyurl.com/nt3xxhg.

Convert Footnotes to Sidenotes in InDesign
Peter Kahrel’s free sidenotes.jsx script converts all footnotes 
in a document to sidenotes (margin notes) that travel with 
the associated text. The script works by creating anchored 
text frames for the notes to sit in, and options let you assign 
the width of the text frames and how far they sit from the 

In The Sept/Oct 
 Software Closet

main text. Styles for the note references are handled by 
existing character styles, and the document’s paragraph style 
applied to footnotes gets duplicated and the name appended 
to keep styling easy to manage. Sidenotes can be numbered—
just as footnotes are—by the page, spread, or section, and 
renumbering can be disabled. Additional scripts also let you 
add new sidenotes as they’re needed and give you the ability 
to stack all sidenotes together at the top, center, or bottom of 
the page. Get it at www.tinyurl.com/purhj7r.

Automatic PDF Tooltips from InDesign
Kerntiff Publishing’s free InDesign PDF Tooltip script 
for InDesign CS5–6 lets you create rollover tooltips in 
an exported PDF. Just select the text that needs a tooltip, 
double-click on the script in the Scripts panel, and enter the 
text you want. After you click on “Make Tooltip,” the script 
will create a button over the selected type. You can tweak the 
tooltip’s placement afterward, and if you need to change the 
text, you’ll do that in the Buttons and Forms panel. Get it at 
www.kerntiff.co.uk.

FontMixer Extends Your Typefaces
Indiscripts’ free FontMixer script for InDesign lets you 
merge characters from individual fonts into a single font, 
which can then be used in most applications. Using the 
simple interface, you’ll choose a name for the new font, select 
both a base font and an additional one to use, pick individual 
characters to include, and then create the composite font. The 
script (which can be used in conjunction with their IndyFont 
script) works in InDesign CS5–CC, but the developer warns 
it is very experimental, so use it with caution. Get it at  
www.indiscripts.com.

Free Fonts

A Font Affair: 14 Free Fonts
At the Going Home to Roost website, Bonnie Forker 
highlights 14 of her favorite free fonts, with links to 
download them, at www.tinyurl.com/obzkdzg.

Halloween fonts:

Ghoulish Fright AOE

Haunt AOE  •  Lovesick AOE

Nightmare AOE  •  ROCKY AOE
Quantum Leap

Twilight  New Moon
Yellow Magician
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mobile app creators, but 
it’s also useful for others.
This update also includes 
many other improve-
ments to Photoshop, in-
cluding enhancements to 
Color Range options, Iso-
lation mode, and path se-
lection, as well as native 
PSDX support (read-only) 
and 32-bit image support 
for many more filters.
To get Adobe Genera-
tor and the other new fea-
tures, either download 
the latest update through 
the Creative Cloud app or 
choose Help> Updates with-
in Photoshop. For more 
information, read Adobe’s 
blog (and watch instruc-
tional videos) at  
www.tinyurl.com/puod94f.  
Or read Jackie Dove’s 
Macworld story at  
www.tinyurl.com/nsv6yjc.

Creative Cloud for 
Photographers
Adobe’s new Photoshop 
Photography Program 
bundle includes Photo-
shop CC, Lightroom 5, 
20GB of cloud storage, 
and a Behance ProSite, all 
for only $10 a month. 
If you just need Lightroom 
and Photoshop, this is a bet-
ter deal than the other pur-
chasing options available. 
The bundle is available 
through December 31st 
to owners of Photoshop 
or Photoshop Extended 
CS3 and up, and if you’re a 
Photoshop CC single-app 
subscriber, you’ll be auto-
matically upgraded to this 
program.
Read Macworld’s story at 
www.tinyurl.com/qf6x3lh.

15

Upgrades

InDesign CC 9.1
Adobe’s latest update to 
InDesign brings it to ver-
sion 9.1 and makes these 
changes:
•	The Sync Settings feature 

is now active. It syncs the 
settings listed in  
Preferences> Sync Settings, 
including workspac-
es, customized menus, 
glyphs, PDF presets, and 
keyboard shortcuts. It 
does NOT yet sync pref-
erence files.

•	Fixes for bugs in creat-
ing new documents with 
Preview turned on.

•	Fixes for hyperlinks in 
exported PDFs.

•	Fixes for font menu 
problems.

•	Fixes for crashes due to 
text issues.

•	Other bug fixes.
For full info on what’s new 
in 9.1, see  
www.tinyurl.com/lfda9dn.

New Photoshop 
Generator
New this month to Photo-
shop CC (version 14.1) is 
Adobe Generator, which 
watches for layers or layer 
groups whose name ends 
in .png, .jpg, or .gif and au-
tomatically exports an im-
age file from that layer or 
layer group. 
If you make a change to 
the layer, the exported file 
is immediately updated. 
This means that you now 
have a folder of images 
that are always up to date 
with your Photoshop de-
sign. It’s aimed at Web and 

QuarkXPress 10
QuarkXPress 10 was re-
leased on Sept 16. We 
saw their demo and were 
very impressed. Here are 
some of the dramatic im-
provements and new abil-
ities you can expect in 
QuarkXPress 10:
•	An entirely new “Xenon” 

graphics engine, which 
provides crystal-clear, 
pixel-accurate previews of 
all page items, including 
imported graphics such as 
PDF, EPS, PSD, AI, TIFF, 
JPG, PNG, and more.

•	Full PDF transparency 
(“pass through”) support.

•	Support for HiDPI dis-
plays, such as Apple’s 
Retina display.

•	 It’s been rewritten for OS 
X as a native Cocoa app, 
with dramatic speed im-
provements and access 
to special OS X features 
such as Recent Items, 
Dictation, File List in 
Dock, and so on.

•	Palettes that automati-
cally dock to the edges of 
the display and automati-
cally show/hide.

•	Full-screen display of 
your document.

•	Giant page previews for 
page navigation.

•	An improved Measure-
ments palette that com-
pletely replaces the old 
Modify dialog.

•	A Quick Response Code 
(QR Code) generator.

•	East Asian typography in 
all editions of QuarkX-
Press 10.

•	 Import pictures and hy-
perlinks from Microsoft 
Word documents.

•	Master pages can now 
have Layers! …more Upgrades on page 16

•	Copy and paste items 
while retaining Layer in-
formation.

•	A new Print Preview 
with thumbnail page pre-
views.

•	Select a Key item for 
Space/Align to align to.

•	Highlight missing fonts.
•	Easily join, extend, and 

close paths created with 
the Pen tool.

•	A giant color swatch 
picker.

•	Apply a style sheet to the 
current paragraph as you 
create the style.

•	Flip shapes horizontally 
or vertically.

•	OS X file extensions now 
added to QuarkXPress 
files. (QXP)

•	Set default tool prefer-
ences from existing ob-
jects.

•	Set separate trim view 
pasteboard color when 
creating Apps in App 
Studio.

•	 Improved IME support 
for Japanese, Chinese, 
and Korean languages.

•	More than 50 productivi-
ty enhancements.

What got left behind:
With this rewrite of the 
code base, QuarkXPress 
10 will only open QuarkX-
Press files back to version 
7. They’ve also dropped 
support for Flash (sur-
prise!), Blio, and HTML 
4 (HTML 5 is SO much 
more capable!).
For visual examples and 
more details, see the story 
at www.tinyurl.com/kmafwky.

Hear Macworld’s Jack-
ie Dove interview Quark’s 
Gavin Drake at  
www.tinyurl.com/ku2tlnr.
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AdManagerPro and 
ProductionManagerPro
For those in advertising, 
MediaSpan announced the 
release of new versions of 
their AdManagerPro ad-
vertising content manage-
ment solution and Produc-
tionManagerPro produc-
tion management system.
Both support QuarkXPress 
9 and InDesign CS6.

www.mediaspanonline.com

Freeway Pro 6
Freeway Pro 6 is a popular 
website-creation applica-
tion with an interface sim-
ilar to QuarkXPress or In-
Design. If Dreamweav-
er leaves you baffled, check 
out this $150 tool. Mac-
world posted a review by 
Michael Burns at  
www.tinyurl.com/njjzscy.

If you’re already a user of 
Freeway Pro 5, see the list 
of new features at  
www.tinyurl.com/p53sgya. Of 
particular note are en-
hanced HTML5 and ad-
vanced CSS3 features, en-
hanced mobile device sup-
port, Retina display sup-
port, and enhanced form 
features.

www.softpress.com

PitStop 12 Solves PDF 
Missing Font Problem
Enfocus has teamed with 
Monotype to provide instant 
access to most common 
fonts from within PitStop 
12. So if you receive a PDF 
with fonts missing, PitStop 
12 may be able to download 
and embed that font for just 
$1.49 per font. The font col-

lection currently includes 
30,000 fonts, and Monotype 
will add new ones from its 
150,000-font collection as 
demand requires.
This new feature is in ad-
dition to dozens of pow-
erful new features, in-
cluding image editing, ac-
tion lists, gradient editing, 
alignment tools, ink us-
age reports, flattening, and 
more. Watch videos on the 
new features on Enfocus’ 
YouTube channel at  
www.tinyurl.com/kobxla2.

Upgrades (from pg.15)

Tricks to Printing 
Multiple Pages
Both QuarkXPress and In-
Design let you print non-
contiguous pages, as well 
as multiple copies of some 
pages and single copies of 
others. 
To print noncontiguous 
pages, type numbers like 
this into the Page Range 
field in the Print dialog 
box: 1, 4, 6-8, 10-12, 15. This 
prints pages 1, 4, 6 through 
8, 10 through 12, and 15. 
To print multiple copies of 
some pages, type the page 
numbers several times, 
like this: 1, 4, 4, 5, 7, 7, 7, 10. 
To print a page in a docu-
ment that starts on a page 
number other than 1, or in 
which you’ve defined mul-
tiple Sections, you need 
to know the page’s abso-
lute page number—the first 
page in the document is al-
ways 1. When you want to 
print that page, add a Plus 
(+) symbol before its abso-
lute page number when you 
type it into the Print dia-
log box. (For example, +5 

prints the fifth page in the 
document, regardless of its 
assigned “page number.”)

Creatively Link and 
Unlink Text Boxes in 
QuarkXPress
To creatively link and un-
link text boxes in Quark-
XPress 9, choose Utili-
ties> Linkster. (If you have 
QuarkXPress 6, 7, or 8 
and have Gluon’s ProPack 
set of XTensions, you also 
have Linkster.) You can 
use Linkster to unlink text 
boxes while maintaining 
the text already in them, 
unlink text boxes across 
multiple pages, or link text 
boxes that already have 
text in them. Quark has a 
three-minute tutorial vid-
eo about Linkster at  
www.tinyurl.com/k22sxzz.

Drag Selections to 
QuarkXPress
In QuarkXPress 8 and 
higher, you can drag just 
about any kind of graph-
ic or text file onto a page 
from anywhere you can 
normally drag a file—the 
desktop, Adobe Bridge, 
Extensis Portfolio, iMedia 
Browser, and so on. You 
can even drag text direct-
ly from inside a Word doc-
ument onto a layout page 
or a selection of an im-
age from inside Photoshop 
onto a page in Quark-
XPress.

Tips (from pg. 13)
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